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Important User Information 
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards. 

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice. 

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired. 

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment. 

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams. 

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual. 

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited. 

Throughout this manual, when necessary, we use notes to make you aware of safety considerations. 

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury 
or death, property damage, or economic loss. 

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attentions 
help you identify a hazard, avoid a hazard, and recognize the consequence. 

IMPORTANT Identifies information that is critical for successful application and understanding of the product. 

Labels may also be on or inside the equipment to provide specific precautions. 

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present. 

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures. 

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash will cause 
severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for Personal 
Protective Equipment (PPE). 

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are not in 
alignment with the movement toward inclusive language in technology. We are proactively collaborating with industry peers to 
find alternatives to such terms and making changes to our products and content. Please excuse the use of such terms in our 
content while we implement these changes. 
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Preface 

This manual provides usage instructions for the FactoryTalk Batch Material 
Editor. It is one of a set of related manuals that describe installing, 
programming, and operating the FactoryTalk Batch system.  

To review FactoryTalk Batch release notes and latest information regarding 
product compatibility refer to the Product Compatibility and Download 
Center (PCDC). 

 
 

Rockwell Automation publishes legal notices, such as privacy policies, license 
agreements, trademark disclosures, and other terms and conditions on the 
Legal Notices page of the Rockwell Automation website. 

End User License Agreement (EULA) 
You can view the Rockwell Automation End User License Agreement (EULA) 
by opening the license.rtf file located in your product's install folder.  

The default location of this file is: 

C:\Program Files (x86)\Common Files\Rockwell\license.rtf 

Open Source Software Licenses 
The software included in this product contains copyrighted software that is 
licensed under one or more open-source licenses.  

You can view a full list of all open-source software used in this product and 
their corresponding licenses by opening the oss_license.txt file located your 
product's OPENSOURCE folder on your hard drive. This file is divided into 
these sections: 

• Components 
Includes the name of the open-source component, its version number, 
and the type of license. 

• Copyright Text 
Includes the name of the open-source component, its version number, 
and the copyright declaration. 

• Licenses 
Includes the name of the license, the list of open-source components 
citing the license, and the terms of the license. 

The default location of this file is: 

About this manual 

Legal Notices 

http://rok.auto/pcdc
http://rok.auto/pcdc
https://www.rockwellautomation.com/global/legal-notices/overview.page
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C:\Program Files (x86)\Common Files\Rockwell\Help\<product 
name>\Release Notes\OPENSOURCE\oss_licenses.txt  

You may obtain Corresponding Source code for open-source packages 
included in this product from their respective project web site(s). 
Alternatively, you may obtain complete Corresponding Source code by 
contacting Rockwell Automation via the Contact form on the Rockwell 
Automation website: http://www.rockwellautomation.com/global/about-
us/contact/contact.page. Please include "Open Source" as part of the request 
text. 

 

Following is a comprehensive list of documentation for the FactoryTalk® 
Batch products from Rockwell Automation. 

Installation, Quick Start, and Getting Results Guides 
Resource Description 

FactoryTalk Batch Components Installation and 
Upgrade Guide 
(BATCH-IN002) 

Provides information and procedures for FactoryTalk Batch system installation. Includes 
information for FactoryTalk Batch Material Manager, FactoryTalk Event Archiver, and 
associated FactoryTalk Batch Client and Server components. 

FactoryTalk Batch View Quick Start Guide 
(FTBVS-QS001) 

Provides information about using FactoryTalk Batch View to create, view, and command 
control recipes, acknowledge prompts and signatures, view equipment phases and 
diagnostic information, and view profile information.  

FactoryTalk Batch View HMI Controls Quick Start Guide 
(BATCH-QS001D) 

Provides a general overview of FactoryTalk Batch View HMI Controls. 

FactoryTalk Batch eProcedure® Getting Results Guide 
(BWEPRO-GR011) 

Explains the basics of FactoryTalk Batch eProcedure. 

FactoryTalk Batch Getting Results Guide 
(BATCH-GR011) 

Introduces the basics of automated batch manufacturing and the FactoryTalk Batch 
product components. 

FactoryTalk Batch Material Manager Getting Results 
Guide 
(BWMTR-GR011) 

Introduces the basics of FactoryTalk Batch Material Manager. 

User Guides 
Resource Description 

FactoryTalk Batch Material Editor User Guide 
(BWMTR-UM001) 

Provides access to information and procedural instructions required to configure materials 
and the containers to hold them. The material data is stored in the material database, 
which is used to create material-based recipes. This information is intended as a reference 
for formulators. 

FactoryTalk Batch Equipment Editor User Guide 
(BATCH-UM004) 

Provides information on creating and maintaining an equipment database (area model). 
The area model is available to all other FactoryTalk Batch programs, including the Recipe 
Editor, Batch View, and Phase Simulator. 

Additional resources 

http://www.rockwellautomation.com/global/about-us/contact/contact.page
http://www.rockwellautomation.com/global/about-us/contact/contact.page
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Resource Description 

FactoryTalk Batch PhaseManager™ User Guide 
(BATCHX-UM011) 

Describes the integration of the FactoryTalk Batch software with the Studio 5000 Logix 
Designer® application and the Logix 5000™ family of controllers. 
The integration simplifies the configuration and maintenance of the FactoryTalk Batch 
automation system, provides better communication between the FactoryTalk Batch Server 
and the Logix 5000 controller, and significantly reduces the programming effort required 
to develop the phase logic code that resides in your Logix 5000 controller. 

FactoryTalk Batch Recipe Editor User Guide 
(BATCH-UM006) 

Provides instructions on using FactoryTalk Batch Recipe Editor to create and configure 
master recipes for use in batch automation. The interface is based on IEC 61131-3 
sequential function charts to organize recipes graphically into procedures, unit 
procedures, operations, and phases. Build recipes using either the SFC format or a table-
based format. 

FactoryTalk Batch View HMI Controls User Manual 
(FTBVS-UM003) 

Provides details about using FactoryTalk Batch View HMI Controls to monitor and interact 
with the production process within a FactoryTalk View SE Display Client.  

FactoryTalk Batch View User Manual  
(FTBVS-UM002) 

Provides information and procedural instructions for using FactoryTalk Batch View in a 
modern and intuitive portal into a comprehensive batching solution for effective 
operations, leveraging its own web server using HTML5 technology to provide connectivity 
into a FactoryTalk Batch Server.  

FactoryTalk Event Archiver User Guide 
(BATCH-UM012) 

Provides information and instructions specific to the FactoryTalk Event Archiver. Intended 
for use by system administrators and production supervisors.  

Administrator Guides 
Resource Description 

FactoryTalk Batch Administrator Guide  
(BATCH-UM003) 

Provides instructions for configuring security and services, and implementation and use of 
components not typically accessed or used by batch operators, such as the FactoryTalk 
Batch Server. 

FactoryTalk Batch eProcedure Administrator Guide 
(BWEPRO-UM011) 

Provides procedures specific to FactoryTalk Batch eProcedure, such as implementing 
security and configuring the user-defined area Active Server Page. 
Included are instructions for tasks specific to FactoryTalk Batch, such as configuring 
security and services to support FactoryTalk Batch eProcedure. Provides instructions on 
the implementation and use of components not typically accessed or used by batch 
operators, such as the FactoryTalk Batch Server. 

FactoryTalk Batch Material Manager Administrator 
Guide 
(BWEPRO-UM011) 

Provides information and instructions specific to FactoryTalk Batch Material Manager. 
Intended for use by system administrators and database administrators. 

Reference Guides 
Resource Description 

FactoryTalk Batch Material Server API Reference 
Manual 
(BWMTR-RM001) 

Provides access to information regarding the interface between the FactoryTalk Batch 
Material Server and the FactoryTalk Batch Material Editor and FactoryTalk Batch. It is 
intended to be used as a reference information by custom interface developers. 

FactoryTalk Batch PCD Programming Reference 
Manual 
(BATCH-RM004) 

Provides information and instructions about the FactoryTalk Batch PCD interface design. It 
is intended to be used as a reference guide for PCD programmers. 



Preface  
 

10 Publication# BWMTR-UM001B-EN-D - May 2022  
 

Resource Description 

FactoryTalk Batch Server API Reference Manual 
(BATCH-RM003) 

Provides information regarding the interface between the FactoryTalk Batch Server and 
FactoryTalk Batch View — the Server Application Programming Interface (API). It is intended 
to be used as a reference guide by custom interface developers. 

FactoryTalk Batch System Files Reference Manual 
(BATCH-RM005) 

Provides the technical information for configuration and maintenance of a FactoryTalk 
Batch system. It can be used as a reference information for implementation engineers and 
system administrators. 

FactoryTalk Batch eProcedure Instruction File Design 
Reference Manual 
(BWEPRO-RM001) 

Includes information about the building of instruction files for use in equipment database 
creation and recipe development. This information is intended to be used as a reference 
by instruction file authors. 

View or download publications at 
http://www.rockwellautomation.com/literature. To order paper copies of 
technical documentation, contact your local Allen-Bradley® distributor or 
sales representative. 

Rockwell Automation recognizes that some of the terms that are currently 
used in our industry and in this publication are not in alignment with the 
movement toward inclusive language in technology. We are proactively 
collaborating with industry peers to find alternatives to such terms and 
making changes to our products and content. Please excuse the use of such 
terms in our content while we implement these changes. 

 

https://www.rockwellautomation.com/literature
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Chapter 1 

Using the Material Editor 

This guide provides access to information and procedural instructions 
required to configure materials and the containers to hold them. The material 
data is stored in the material database, which is used to create material-based 
recipes. This guide is intended as a reference for the formulator. 

The Editor interface is similar to Windows Explorer in the way items are 
displayed and the way you navigate within the application. The Editor has five 
standard areas: menu bar, toolbar, hierarchy pane, detail pane, and status bar. 

The menu bar is similar to the standard menu bar found on most Windows 
applications. The menu bar contains the drop-down menus for File, Edit, 
View, Tools, and Help. 

This table describes the menu bar commands: 

Item Definition 

File Provides options for creating new objects, printing objects, and exiting the Editor. 

Edit Provides options for deleting selected items and viewing item properties. You use the Properties 
option for editing various items. 

View Allows you to show or hide the toolbar and status bar. You can also specify how data is viewed in 
the Detail pane and set user preferences for the Editor. 

Tools Allows you to configure system properties. 

Help Provides you with on-line help and information regarding the software and the system. 

The Material Editor interface 

Menu bar 
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The Editor toolbars are mode-specific, meaning the available icons on the 
toolbar change depending on the current mode of the Editor. The following 
table describes the options available on the various toolbars. 

Icon Description Mode/View 

 
Create new item of the type of item currently selected All 

 
Print preview All 

 
Cut selected item All 

 
Copy selected item All 

 
Paste selected item All 

 
View properties of the selected item All 

 
Go to the folder one level up All 

 
Invoke online help for the Editor All 

 
Display items by using large icons All 

 
Display items by using small icons All 

 
Display items in list format All 

 
Display detailed information for each item in the list view All 

 

The left pane, called the Hierarchy pane, always contains a hierarchical (tree) 
view of the Editor data — much like the list of folders and files shown in 
Windows Explorer. The Hierarchy pane is a visual representation used to 
navigate through the data. The hierarchical tree view is the principal 
mechanism for accessing the application data and controlling how the data is 
viewed in the Detail pane. 

• Material Configuration List contains a list of available materials. 
• Material Storage Configuration List contains a list of storage 

containers and locations that are used for storing the various 
materials. 

The right pane, called the Detail pane, always contains a view that represents 
one or more data items in the Hierarchy pane. This view is used to display the 
data in more detail. The detail pane is the principal mechanism for viewing 

Toolbars 

Hierarchy pane 

Detail pane 
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the application data in detail. It is generally a list view, but may also be an 
editable table view, a form view, or a graphical view. 

• Material Configuration  
• Material Storage Configuration 
• Materials 
• Locations 
• Independent Containers 

The List View mode of the Detail pane contains data items in a columnar or 
icon format, depending on the mode and selected item. There are four ways 
to display the data items in the List View (the associated toolbar button is seen 
to the left of each description):  

Icon Display Description 

 
Large icons Each item appears as a full-sized icon (32 x 32 pixels) with a label below it. You can 

drag the items to any location in the List View. 

 
Small icons Each item appears as a small icon (16 x 16 pixels) with the label to the right of it. You 

can drag the items to any location in the List View. 

 
List Each item appears as a small icon with a label to the right of it. Items are arranged 

in columns and cannot be dragged to any location in the List View. 

 
Details Each item appears on its own line, with additional information arranged in columns 

to the right. The leftmost column contains the small icon and label, and subsequent 
columns contain subitems as specified by the Editor. 

With the exception of the first column of data in the List View, you cannot 
directly edit the data items. You can edit the data in the first column directly 
or right-click the desired item and select Rename. 

 

The status bar at the bottom of the Editor window usually displays a text 
message or state on the left side and the standard Caps Lock, Scroll Lock, and 
Num Lock states on the right side. In addition, to the immediate left of the 
Num Lock state, the status bar may display one or more icons representing 
the state and status of the Editor and/or its data.The following is a list of 
states that may be displayed in the status bar:  

Icon Item Description 

 
Database The Editor is accessing data. 

 
Error An error occurred when editing data. 

 
Information The currently selected data is predefined and not editable. 

 
Warning A message displays a warning. 

 
Critical A message displays critical error information. 

List view 

Status bar 
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Question A message displays a question. 

 
Searching The Editor is searching for data. 

 
Secured The currently selected data is secured. 

 
Printing A report is being printed or previewed. 

 
Processing The Editor is processing data. 

 
Waiting The Editor is busy. 

 
Verification Data is being verified. 
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Chapter 2 

Configuring the Material Editor 

There are several settings you can choose from to configure the Material 
Editor. You can turn on information tips, change the text and background 
colors of the application, configure the various views, and set up reports used 
for printing recipe data. You can also change the location of the Material 
Server. 

The User Preferences function allows you to customize the behavior and 
appearance of the various panes and views within the Editor application. 

1. From the View menu, select User Preferences. The User Preferences
dialog box opens to the General tab.

The General tab is used to configure the basic behavior and 
appearance of the Material Editor views and dialog boxes. The 
selections on the General tab are used in conjunction with other 
sections of the User Preferences dialog box. 
In the Options area you have the following selections: 

• Use application colors: Select to assign colors, other than the
current Windows colors, to the background and text in the views.
(See Changing colors on page 16 for more information.)

• Use application font: Select to change the font, font style, and size
from the default Windows style. (See Changing fonts on page 16 for
more information.)

Setting user preferences 

Setting general preferences 
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• Information tips: Select to enable single line tips that appear when 
you move the cursor over a button or field. (See Editing information 
tips on page 17 for more information.) 

• Animate dialogs: Select to have dialog boxes fly out from the 
location from which they are opened. 

• Confirm deletion: Select to display an "Are you sure?" message when 
you delete an item. Leave disabled to delete an item immediately 
without confirmation. 

• Confirm exit: Select to have the application ask if you want to exit. 
Leave disabled to exit without a confirmation message. 

2. Make the desired selection, and then click Apply. 

The Material Editor defaults to the current Windows color scheme. You can 
change the color of the text and background. 

1. On the General tab in the User Preferences dialog box, select Use 
application colors. 

2. Select the Colors tab. 

 
3. Disable Use Windows colors to enable the Background color and Text 

color lists. 
4. Select the desired colors from the appropriate list, and then click 

Apply. 

The Material Editor defaults to the current Windows fonts. You can change 
the display font. 

1. On the General tab in the User Preferences dialog box, select Use 
application font. 

Changing colors 

Changing fonts 
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2. Select the Font tab. 

 
3. Click the Select Font button. The Font dialog box opens. 
4. Select the desired font, style, and size from the appropriate lists, and 

then click Apply. 

Information tips appear when you move the cursor over a button or field. You 
can change the font and colors of tips, and set tip timing, which determines 
how soon a tip displays. 

1. On the General tab of the User Preferences dialog box, select 
Information tips to enable tips. 

2. Select the Tips tab. 

 
3. To enable the Background color and Text color lists, disable Use 

Windows colors. 
4. To change the tip color, select the text and background colors from the 

appropriate lists, and then click OK. 

Editing information tips 
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5. To change the tip font, click the Change Font button. The Font dialog 
box opens. Select the desired font, style, and size from the appropriate 
list, and then click OK. 

6. To change the timing of information tips, use the Up and Down arrows 
to change the settings in the Timing area. 

• Delay determines how soon a tip displays when the cursor stops on 
an area with a tip. 

• Visible duration determines how long the tip stays visible before 
closing. 

7. Click Apply. 

If you want to configure properties specific to each view and list in the Editor, 
use the Views tab. For all list views, you can enable information tips, alter the 
behavior of drag and drop, change the appearance of scroll bars, and set 
selection options. On selected views, you can change the font style and color, 
as well as the background color. 

 

The List View Properties area contains the following options to change the 
appearance and behavior of items seen in a list view. 

• "Hot" list selection – If selected, an item is automatically highlighted 
and selected when the cursor remains over the item for a certain 
period of time. 

• List information tips – If selected, single-line tips appear when you 
move the cursor over a button or field. See Editing information tips on 
page 17 for more information.) 

• Flat scroll bars – If selected, scroll bars appear 2-dimensional. If 
disabled, scroll bars have a 3-dimensional appearance (Windows 

Changing view properties 

Changing list view 
properties 
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default). The following figure illustrates both the default (on the left) 
and flat (on the right) scroll bars: 

 
• Header drag and drop – If selected, users can click and drag a header 

from one location to another in order to rearrange the columns. 
• Header "hot" tracking – If selected, an item is automatically 

highlighted but not selected when the cursor moves over a header 
item. You must still click the item at least once to activate it. 

• Subitem images – Not currently enabled. 

You can change the font, font style, or font size for a selected view. 

1. Select the Views tab on the User Preferences dialog box. 
2. In the General View Properties area, select a view, and then click the 

Edit View Properties button. The View Properties dialog box opens to 
the Colors tab. 

3. Select the Font tab, and then click the Change Font button. The Font 
dialog box opens. 

4. Select the desired font, style, and size, and then click OK. The View 
Properties dialog box displays the selections you made. 

5. Click OK to return to the User Preferences dialog box. 
6. Click Apply. 

You can change the colors used in a selected view. 

1. Select the Views tab on the User Preferences dialog box. 
2. In the General View Properties area, select a view, and then click the 

Edit View Properties button. The View Properties dialog box opens to 
the Colors tab. 

3. To enable the Window Background, Text Background, and Text lists, 
disable Use Windows colors. 

4. Select the desired color for the window background (if applicable), text 
background, and text color from the appropriate lists, and then click 
OK. 

5. Click Apply. 

The Detail pane contains data items in columnar or icon format. With the 
exception of the first column of data in the Detail pane, the data items cannot 
be edited directly. The data in the first column can be edited directly or by 
using the shortcut menu and selecting Rename. 

If you select List in the User Preferences dialog box, you can manipulate the 
columns and rows in the Detail pane as described in this table. 

Item Description 

Sorting columns Click a column header to sort the items in the column alphabetically or numerically. 

Changing view fonts 

Changing view colors 

Working with columns and 
rows 
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Sizing columns Automatically: To make the column width fit the contents, double-click the boundary 
to the right of the column heading. 
Manually: Drag the boundary on the right side of the column heading until the column 
is the desired width. 

Editing the item name Click once on a row to highlight it, and then click again. The item name will be encased 
in an editing box so that you can rename the item. 
Double-click on a row to open the Properties dialog box, allowing you to edit the item 
name. 
Right-click on a row to display the shortcut menu; select Rename. 

Editing a row Double-click on a row to open the Properties dialog box to edit the row’s information. 
Right-click on a row to display the shortcut menu; select Properties or other editing 
operations. 

Copy, delete, or move rows Right-click on a row to display the shortcut menu; select Cut, Copy, Paste, or Delete. 

 

You can select which materials are visible in the Materials list and how they 
display. 

 

You can select exactly which materials you want displayed by setting a filter. 
Filters are used to sort the material names and display particular ones. For 
instance, you could filter the material list to display only those material names 
containing a certain word or words. 

1. From the User Preferences dialog box, select the Materials tab. 
2. In the Material Name Filtering area, select the desired filtering option: 

None – Disables material filtering; the Material Name field is disabled. 
Exact match – Lists materials with names that match the filter text. 
Containing – Lists materials with names that contain the filter text. 

Configuring the materials 
list 

Enabling material name 
filtering 
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First – Lists only those materials with names that begin with the filter 
text. 
Last – Lists only those materials with names that end with the filter 
text. 

3. In the Material Name box, type the text to use as a filter. 
4. Click Apply. The materials are reordered, with the filter applied. 

You can display the materials in list form (default) by type or by class. If you 
choose to display by type or class, you can select to display only certain types 
or classes of materials. 

1. From the User Preferences dialog box select the Materials tab. 
2. In the Materials Display Format area select the desired display format: 

• List (default) 
Displays the materials in alphabetical list form (as shown) 

 
• By Type 

Displays the materials by their type (for example; Finished, 

Configuring the material 
display 
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Intermediate, or Raw) or you can select all three to display the 
materials in a hierarchy view by type (as shown). 

 
• By Class 

Displays the materials by their class designation (for example; 
Colorings, Flavorings, etc.) or you can select all classes to display the 
materials in a hierarchy view by class (as shown). 

 
3. Click Apply. The Material list is refreshed, with the display format 

applied. 

You do not have to select a Material Server after installation. It is done 
automatically. However, in a case where the server becomes disabled or is 
removed from the system, you must select a different server, which you can 
do easily from the Editor. 

Selecting another Material 
Server 
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1. From the Tools menu, select System Configuration. The System 
Configuration dialog box opens. 

 
2. Click the Browse button. The Select Computer dialog box opens. 
3. Select the new server from the list of computers. 
4. Click OK to return to the Server Options dialog box. The system 

configuration information is updated from the Network Editor of the 
selected server. 

5. Click OK to exit System Configuration. 

The report printing feature of the Editor allows you to print lists of the 
materials, containers, and other items in the database, in a report formatted 
with headers, footers and column headings (in list reports). There are two 
report formats available: formatted and list. The header (at the top of the 
page) consists of the report name, while the footer (at the bottom of the page) 
contains the date and time of printing and the page count. 

A formatted report presents the information down the page, with bold field 
names as shown in this figure. 

A list report presents the data in a columnar, spreadsheet format, with one 
line per data item. The field names become column headings as shown in this 
figure. 

You can customize the reports by setting margins, changing font styles, and 
selecting text colors. In addition, you can enter custom text that is also 
included in the footer. See Setting report preferences on page 24 for more 
information.  

The Print Preview function of the Editor allows you to see how a printed 
report will look before you send it to the printer. 

1. Click the Print Preview button. The Print Preview window opens, 
displaying the report as it will look when printed. The following 
options are available from the Print Preview window: 

• Next Page – If there is more than one page in the report, click Next 
Page to view the next page of the report. 

• Prev Page – Click to view the previous report pages (if there is more 
than one page in the report). 

Generating printed reports 

Previewing reports 
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• Two Page – Allows you to view two pages of a report in the same 
window. 

• One Page – Returns to the default preview setting of one page per 
window. 

• Zoom In/Out – Click Zoom In to magnify the preview page. Click 
Zoom Out to reduce the size of the page in the preview window. 

• Close – Closes the preview window. 

2. Click Close to return to the Editor. You can either print the report or 
make additional report configuration changes. 

1. In the Editor’s Hierarchy pane, select the list or item(s) that you want 
to print. 

2. From the File menu, click Print. You could also click the Print button 
or press ctrl+p to display the Print dialog box. 

3. Ensure that the correct printer is selected, and click OK. 

 
Tip: To configure heading and footer fonts, and add a custom footer to your reports, see Setting 
report preferences on page 24 for instructions. 

Printing a Range of Reports 
Occasionally, you may want to print just certain pages of the report. You can 
do so by entering the starting and ending page numbers of the section you 
want printed. 

1. In the Editor’s Hierarchy pane, select the list or item(s) that you want 
to print. 

2. Click Print. 
3. In the Page Range area, click Pages. Type the page numbers to print in 

the From and To boxes. 
4. Ensure that the correct printer is selected and click OK. 

You can define a footer to print on every page of the report and select the font 
and color (if your printer supports color printing) for the various sections of 
the report. 

1. From the View menu, select User Preferences. The User Preferences 
dialog box opens to the General tab. 

Printing reports 

Setting report preferences 
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2. Select the Reports tab. The default report style for most views is 
Formatted. 

 
The Reports tab contains the following items: 
Item Description 

Report column Lists the report templates available for the item or view that is currently active in 
the Editor. 

List check box Enables the list report style, if available for the associated report. 
Formatted check box Enables the formatted report style, which is the default format for most reports. 
Include Related Data check box Adds any additional data associated with the selected item to the printed report. 
Footer Text Prints the word or phrase entered at the bottom of each report page. 
List Reports button 
Formatted Reports button 

Opens the Report Page Configuration dialog box where you can set the margins, 
font, and text color for a specific report template. 

Graphical Reports button Not enabled in Material Manager. 

3. To change the type of printed report, select either List or Formatted to 
the right of the appropriate report. 

 
Tip: If you select the List format, set the page orientation to landscape. From the File menu, select 
Print Setup, select Landscape in the Orientation area, and then click OK. 

4. Where available, you can select Include Related Data, and any 
additional data associated with the selected item (single items only – 
not lists or groups) also prints on the report. 

5. In the Footer Text box, type a word or phrase to appear centered at the 
bottom of each page. 

6. Click Apply. 
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1. To change the margins, fonts, and colors of a printed report, click the 
desired Report button (List, Formatted, or Graphical). The Report 
Page Configuration dialog box opens. 

 
2. Change the margin widths of the printed report if desired. Type the 

desired amounts in each box for the Left, Right, Top, and Bottom 
margins. A visual representation of each margin change displays in the 
Report page preview area. Note that this is not to scale. 

3. If you want to use inches instead of metric measurements, disable 
Metric Measurements. 

4. Click OK to close the Report Page Configuration dialog box. 
5. Click Apply. 

You can change the font type, style, and size of each section in the report 
template. 

Changing margins 

Setting the report fonts and 
colors 
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1. From the Formatted Report Page Configuration dialog box, select the 
Fonts tab. 

 
There are four areas in a report for which you can edit the fonts and 
colors: 

• Heading – Prints across the top of each page, generally in a larger, 
bolder font than the rest of the report. 

• Sub Heading – Refers to the field names, such as Material Name or 
Group. In formatted reports, sub headings print to the left of the 
actual report data. 

• Body – Refers to the actual report data text, which is usually smaller 
and lighter than the headings. 

• Footing – Prints the page number, date, and time that the report is 
printed across the bottom of each page, generally in a smaller font 
than the rest of the report. 
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2. Click the button for the report section you want to edit. The Font 
dialog box opens. 

 
3. Select the desired font, font style, and size, and then click OK. 
4. If your printer supports color printing, you can add color to the report. 

Select the Colors tab. 

 
5. Click the color selection button corresponding to the report section to 

which you want to add color. The Color dialog box opens. 
6. Select a color from the Color dialog box, and then click OK. You will see 

a visual representation of each color change in the Report page preview 
area of the dialog box. 
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7. Repeat for the other sections of the report, as desired. When you are 
finished changing fonts and colors, click OK to close the Report Page 
Configuration dialog box. 

8. Click Apply. 
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Chapter 3 

Configuring states 

The state of a lot informs others about the availability of a material. When a lot 
of material is assigned the state of Ready To Use, it can be distributed to its 
configured containers and used in a recipe. You can use lot states to keep 
certain lots of material from being used in a recipe. For instance, you can 
assign a Rejected state to a material that does not conform to standards. Since 
the state is not Ready to Use, the FactoryTalk Batch Server does not use the 
material. 

The same rule applies to the state of a container. If a container is not Ready To 
Use, you cannot distribute material to that container, either as an addition of 
material from a container to a recipe, or the distribution of material to a 
container from the recipe. You can use container states to keep certain 
containers from being used. For example, when a container needs a 
maintenance check, assign the Maintenance state. Since the state is not 
Ready to Use, the FactoryTalk Batch Server does not use the container. 

The States Configuration option allows you to pre-configure descriptive 
information about the lot and container states, but not report an actual 
quantity of that lot or container.  

Tip: The FactoryTalk Batch Server can bind a recipe only to a material or container that is Ready To Use. 

1. From the Edit menu, select States. The States Configuration dialog
box opens to the Lot tab.

Tip: You cannot edit or delete the system-defined Ready To Use state. 

Creating new states 
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2. If you are creating a container state, select the Container tab. If you 
are creating a lot state, skip this step. 

3. Click the New State button. The Create Lot (or Container) State dialog 
box opens. 

4. In the Name box, type a unique name for the state. 
5. In the Description box, type a detailed description of the state. 
6. The Controller ID field defaults to the next numeric value in sequence, 

or you can change it to a unique number. This ID is provided to allow 
the PLC programmer to access a sublot record from the material 
database. 

7. Click OK to save the new state. 

1. From the States Configuration dialog box, select the Lot or Container 
tab. 

2. Select the record row to edit, and then click the Edit State button. The 
Edit Lot (or Container) State dialog box opens. 

3. Make the necessary changes, and then click OK. 

1. From the States Configuration dialog box, select the Lot or Container 
tab. 

2. Select the record row to delete, and then click the Delete State button. 

 
Tip: You cannot delete a lot state that is assigned to a material. You must either edit the material 
to assign a different state or delete the material. Additionally, you cannot delete a container state 
that is assigned to a container. You must either edit the container to assign a different state or 
delete the container. 

 

 

Editing states 

Deleting states 
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Chapter 4 

Configuring material types 

A material type is the descriptive state of a material. The Material Manager 
has three default material types: 

• Finished is a process output (final product such as vanilla ice cream),
which is the quantity of a material that is distributed after the
execution of a recipe. 

• Raw is a process input, which is the quantity of material, such as milk
or eggs, added for the execution of a recipe. 

• Intermediate can be both a process input or a process output.

1. From the Edit menu, select Material Types. The Material Types dialog
box opens.

2. Click the Add button. The Edit Material Type dialog box opens.

3. In the Name box, type a unique name for the selected material.

Creating material types 
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4. In the Description box, type a detailed description of the selected 
material. 

5. The Controller ID field defaults to the next numeric value in sequence. 
If necessary, you can change this to a unique number, which is used for 
PCD phase programming. (See the FactoryTalk Batch PCD Programming 
Reference Guide for more information.) 

6. Click OK to save the new material type. 

1. From the Material Types dialog box, select the type, and then click the 
Edit button. 

 
2. Make the necessary changes to the material type information, and then 

click OK. 

Use this procedure to delete material types. 

To delete material types: 
1. From the Material Types dialog box, select the type, and then click 

Delete. 
2. If Confirm deletion is enabled on the User Preferences dialog box, a 

confirmation message opens. To delete the type, click Yes. 

If Confirm deletion is disabled on the User Preferences dialog box, the 
material type is deleted without a confirmation message. (See 
Configuring the Material Editor for more information.) 

 
Tip: You cannot delete a material type that is assigned to a material. You must either edit the 
material to assign a different type or delete the material. 

 

 

Editing material types 

Delete material types 
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Chapter 5 

Configuring material classes 

A material class defines one or more materials that are considered similar to 
each other. An example of a material class is Sweetener, which could contain 
the materials Granulated Sugar and Corn Syrup. Using material classes 
simplifies adding materials to storage containers — you can then add the 
whole class of materials to a container, instead of adding each material 
individually. 

You can also define properties for material classes, which propagate to all 
materials created with reference to a material class. For example, if the 
material brown sugar is based on the sweeteners material class, which has 
defined material class properties, such as color and melting temperature, then 
brown sugar automatically inherits those material class properties. You can 
then modify the inherited material class properties by deleting inherited 
properties that do not pertain to the material, or change the minimum, 
maximum, and default values. 

1. From the Edit menu, select Material Classes. The Material Classes
dialog box opens listing the currently defined material classes.

Creating material classes 
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2. Click the Add button. The Create Material Class dialog box opens to 
the General tab. 

 
3. In the Name box, type a unique name for the new class. 
4. In the Description box, type a detailed description for the new class. 
5. The Controller ID field defaults to the next numeric value in sequence. 

If necessary, you can change this to a unique number, which is used for 
PCD phase programming. (See the FactoryTalk Batch PCD Programmer 
Technical Reference Guide for more information.) 

6. Click Apply to save the changes. The Edit Material Class dialog box 
opens. 

7. Select the Properties tab, and then click the New Property button. 

 
The following is a list of the items in the Properties tab.  
Item Description 

Material Class Property Unique name assigned to the material class property. 
When a class is assigned to a material, all property names (class properties and 
independent properties) must be unique. Names of material class properties 
cannot be the same as material properties that belong to a material assigned to 
the class. (See Add material properties on page 43.) 

Type Represents the data type from which the provided value is to be derived. There 
are three data types supported: Real, Integer, and String. 

 
Tip: Unsigned data types introduced in Logix5000 version 32.00 
are not supported by FactoryTalk Batch. Configuring a FactoryTalk 
Batch tag to reference a controller tag of any unsigned data type 
(USINT, UINT, UDINT, ULINT) will result in bad communication. If you 
attempt to run batches referencing any tags that include one of 
these data types a communication failure occurs at the point when 
the tag is used.  
Use FactoryTalk Batch Tag Verify to produce a report that identifies 
any issues with the tag(s). 
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Item Description 

Minimum Minimum value for the material class property. Cannot be greater than the 
maximum value. 

Maximum Maximum value for the material class property. Cannot be less than the 
minimum value. 

Default Value Default value for the material class property. Must be between Minimum and 
Maximum values. 

EUs Engineering unit of measure for the material class property. 

Controller ID Defaults to the next numeric value in sequence. If necessary, you can change 
this to a unique number to be used for PCD phase programming. 

Synchronize Select to propagate changes to all inherited material and lot properties. This 
selection is necessary only when you make changes to a material property. 

Description Detailed description of the material class property. 

8. Type the information in the appropriate boxes to define the material 
class property. 

9. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

1. From the Material Classes dialog box, select the class, and then click 
the Edit button. The Edit Material Class dialog box opens. 

 
2. Make necessary changes, and then click Apply. 

Use this procedure to edit material class properties. 

To edit material class properties: 
1. If you need to change the material class properties, select the 

Properties tab from the Edit Material Class dialog box. The currently 
defined material class properties display in a table format. You can 

Editing material classes 

Edit material class 
properties 
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also use a form to make changes. See Using a form to edit material 
class properties for more information. 

 
2. Make the desired changes. You cannot change the Type. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value containing a decimal. If you type over the old value 
containing the decimal, the new decimal is not recognized by the application. 

3. If you want to propagate the changes to all material and lot properties 
that are based on this material class, select Synchronize.  

4. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

 

1. On the Properties tab, select the record row to edit, and then click the 
Edit Property button. The Edit Material Class Property dialog box 
opens. 

 
2. Make the desired changes. You cannot change the Type. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

3. If you want to propagate the changes to all material and lot properties 
that are based on this material class, select Synchronize. 

Using a form to edit material 
class properties 
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4. Click OK. 

1. From the Material Classes dialog box, select the class, and then click 
Delete. 

2. If the Confirm deletion is enabled on the User Preferences dialog box, 
a confirmation message opens. To delete the class, click Yes. 

If the Confirm deletion is disabled on the User Preferences dialog box, 
the material class is deleted without a message (see Configuring the 
Material Editor on page 15 for more information). 

IMPORTANT You cannot delete a material class that is assigned to a material. You must either 
assign a different material class to the material or delete the material. 

 

1. From the Material Classes dialog box, select the class, and then click 
the Edit button. The Edit Material Class dialog box opens. 

2. Select the Properties tab. 
3. Select the record row to delete, and then click the Delete Property 

button. 
4. Click Apply to save the changes, or click OK to save the record and 

close the dialog box. 
 

Deleting material classes 

Deleting material class 
properties 
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Chapter 6 

Configuring materials 

The Material Editor is used to facilitate easy configuration and manipulation 
of the material-based recipes database. Material configuration is the process 
of adding, editing and deleting various material data that is stored in the 
material database. 

When adding materials, you must create a general description record of the 
material before you can define the other attributes of the material. 

1. Right-click Materials in the Hierarchy pane and select New Material
(or click the New toolbar button). The Create Material dialog box
opens.

The following is a list of items in the Create Material dialog box: 
Item Description 

Name Unique name assigned to the material (required). 

Description Detailed description of the material. 
Inventory Key Provides an interface for integrating in-house material inventory systems to 

plant production processes. 

Engineering Units The unit of measure being used for this material. 

Type The Material Type to which this material belongs (required). Defaults to Raw 
material type. 

Class The Material Class to which this material belongs (required). Defaults to 
Ungrouped material class. 

Default Lot State All lots derived from this material default to this state. 

Controller ID Defaults to the next numeric value in sequence. If necessary, you can change 
this to a unique number to be used for PCD phase programming. 

Last Edited By System name of the user who last changed the material record (view-only). 

Creating a material record 
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Item Description 

Last Modified Date and time record last modified based on the system date and time (view-
only). 

2. Type the information in the appropriate boxes to define the material. 
3. Click Apply to save the information. The Edit Material dialog box 

opens. 

 
The Edit Material dialog box contains the following tabs: 

• Properties: A list of custom attributes that are associated with the 
material. This data is optional information and is not required. (See 
Configuring material properties on page 43 for more information.) 

• Lots: The information that identifies a particular quantity of a 
material. A lot holds all of the static information about the lot, such 
as Lot Identifier, Material Type, State of the lot, Engineering Units, 
and Controller ID value). (See Configuring material lots on page 45 
for more information.) 

• Containers: The definition of some type of storage that holds 
materials. Some containers hold one material (such as a bin or 
tank), and others can hold multiple materials (such as a pallet). 
Containers can be a source for materials (adding materials from the 
container) or the destination for materials (such as the distribution 
of a finished product). (See Configuring containers on page 50 for 
more information.) 

• Priorities: Used to select which container of material you want to 
use first. For example, a container that has the oldest material must 
be used before newer materials. In the Priorities column, the 
default priority value is 100. The allowed values are 1 to 100, with 1 
being the lowest value, which is selected first. You can assign as 
many priorities per container as needed. If the container with the 
value of 1 runs out of material, the next priority for that container is 
used. (See Configuring material priorities on page 52 for more 
information.) 

• Inventory: A view of the material lot distribution. Each row 
represents a sublot. A sublot is an amount of material in the selected 
lot that has been distributed to a container. The container, lot, and 
label are used by the FactoryTalk Batch Server when searching for a 
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material to bind to a recipe. (See Configure material inventory on 
page 52 for more information.) 

The Properties tab contains a list of custom attributes that are associated 
with the material. This data is optional information and is not required. 
Custom attributes always have indexes starting at 1000. Since a material 
could be composed of numerous property elements, you can add numerous 
property records. Additionally, it allows you to edit existing properties and 
delete properties from the list. 

For materials that might have the same custom properties, you can duplicate 
properties with the same Controller ID to multiple containers. For example, if 
two materials have a pH_Factor property, you can assign the property to both 
materials using the same Controller ID. 

Use this procedure to add material properties. 

To add material properties: 
1. If the Edit Material dialog box is open, click the Properties tab. 

If not, right-click on a material in the Hierarchy or Detail pane, and 
select Properties. The Edit Material dialog box opens. Click the 
Properties tab. 

2. Click the New Property button to create a new property record row. 

 
The following is a list of items on the Properties tab: 
Item Description 

Material Property Unique name assigned to the material property (required). 
All property names (material class properties and independent material properties) 
must be unique. Names of material class properties cannot be the same as material 
properties that belong to a material assigned to the class. See Creating material 
classes for more information. 

Class Property Name of the inherited material class property (view only). 

Configuring material 
properties 

Adding material properties 
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Item Description 

Type Represents the data type that the provided value is to be derived from (required). 
There are three data types supported: Real, Integer, and String. 

 
Tip: Unsigned data types introduced in Logix5000 version 32.00 are not 
supported by FactoryTalk Batch. Configuring a FactoryTalk Batch tag to 
reference a controller tag of any unsigned data type (USINT, UINT, UDINT, 
ULINT) will result in bad communication. If you attempt to run batches 
referencing any tags that include one of these data types a 
communication failure occurs at the point when the tag is used.  
Use FactoryTalk Batch Tag Verify to produce a report that identifies any 
issues with the tag(s). 

 

Minimum Minimum value for the material property. Cannot be greater than the maximum 
value. 

Maximum Maximum value for the material property. Cannot be less than the minimum value. 
Default Value The default value for the material property. Must be greater than the minimum value 

and less than the maximum value for the material property. 

EUs Engineering unit of measure for the material property. 

Controller ID ID numbers begin at 1000 and increment by 10 for each attribute added. If 
necessary, you can change this to a unique number to be used for PCD Phase 
Programming. 

Description Detailed description of the material property. 

3. Type the information in the appropriate boxes to define the material 
property. 

4. Click Apply to save the record, or click OK to save the record and close 
the dialog box. 

 

1. If the Edit Material dialog box is open, select the Properties tab. 

If not, right-click on a material in the Hierarchy or Detail pane, and 
select Properties. The Edit Material dialog box opens. Select the 
Properties tab. The currently defined material properties display in a 
table format. You can also use a form to make changes. 

 
For inherited material class properties, you can change only the 
minimum, maximum, and default values.  

2. Modify the material property as desired. 

Editing material properties 
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IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

3. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

 
Tip: Changing a duplicate property that is assigned to other materials does not affect the other 
properties. 

 

1. On the Properties tab, select the record row to edit, and then click the 
Edit Property button. The Edit Material Class Property dialog box 
opens. 

 
2. Modify the material property as desired, and then click OK. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

3. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

 
Tip: Changing a duplicate property that is assigned to other materials does not affect the other 
properties. 

 

1. From the Edit Materials dialog box, select a record row to delete, and 
then click the Delete Property button. 

2. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

 
Tip: Deleting a duplicate property that is assigned to another material does not affect the other 
material’s property. 

 

The Lots tab contains the information that identifies a particular quantity of a 
material. A lot holds all of the static information about the lot, such as Lot 
Identifier, Material Type, State of the lot, Engineering Units, and Controller 
ID value. A lot may also contain sublots, which detail the actual quantity of the 
lot that is distributed into material storage containers. An example of a lot 

Using a form to edit material 
properties 

Deleting material properties 

Configuring material lots 
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could be: Shipment number SN2009 of the material Granulated Sugar, which 
is part of the material class Sweetener and is classified as a Raw material type. 

1. From the Edit Material dialog box, select the Lots tab. Existing lots 
display in ascending order by lot name. You can sort the list by 
clicking the column header to display an up arrow (ascending) or 
down arrow (descending). 

2. Click the New Lot button to insert a new lot record row. 

 
The following is a list of items on the Lots tab: 
Item Description 

Lot Name Unique name to identify the lot (required). 

State Current state of the lot (required). 
Quantity Total amount of this lot of material (required). 
Creation Date Date and time the lot was added (view-only). 
Depletion Date Date and time the lot was deleted (view-only). 
Controller ID Defaults to the next numeric value in sequence. You can change this to a 

unique number for PCD phase programming. 

Description Detailed description of the lot record. 

Refresh button Re-queries the materials database for lots of this material and repopulates 
the displayed lot records. 

3. Type the information in the appropriate boxes to define the material 
lot. 

4. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

1. From the Edit Material dialog box, select a record row to delete, and 
then click the Delete Lot button. 

2. Click Apply to save, or click OK to save and close the dialog box. 

You can change the material’s properties and the amount of material in the 
lot, and distribute a lot of material to a container. 

Adding new lots 

Deleting lots 

Editing a lot 
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1. From the Edit Material dialog box, select a record row to edit, and then 
click the Edit Lot button. The Edit Lot dialog box opens to the General 
tab. 

 
2. Modify the general lot information as needed, and then click Apply. 
3. Select the Properties tab. The properties assigned to the lot of material 

display. You can change the value of the property directly in the Value 
column or use a form. 

 
4. In the Value box, type a new value for the property. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

5. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

Using a form to change lot 
properties 
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1. On the Properties tab, select the record row to edit, and then click the 
Edit Property button. The Edit Lot Property dialog box opens. 

 
2. In the Value box, type the value of the property, and then click OK. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

 

When you distribute a lot, you create a sublot that is identified by a label. A 
sublot is an amount of material in the selected lot that is distributed to a 
container. 

 
Tip: Before creating distributions, verify that both the material lot and container have a state of Ready to 
Use. 

1. From the Edit Lot dialog box, select the Storage tab. Existing sublots 
display in ascending order by label name. Each record row represents 
a sublot. You can sort the list by clicking the column header to display 
an up arrow (ascending) or down arrow (descending). 

 

Distributing a lot 
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2. Select the record row to distribute, and then click the Distribute 
button. The Distribute Lot dialog box opens. 

 
3. In the Label box, type a unique name for the sublot. 
4. In the Quantity box, type the amount to distribute. 
5. From the Storage Container list, select a container to store the 

distributed amount. 
6. Click OK to return to the Storage tab on the Edit Lot dialog box. 
7. Click Apply to save the changes, or click OK to save the record and 

close the dialog box. 
 

1. From the Edit Lot dialog box, select the Storage tab. The distributed 
amounts of the lot display. 

 
Tip: If you edit a sublot by distributing the lots of material, deleting a distribution, or changing the 
amount of material, the material's inventory information also changes. 

Changing a sublot quantity 
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2. Select the record row to edit, and then click the Edit Distribution 
button. 

 
3. In the Quantity box, type a new amount. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application 

4. Click OK to return to the Storage tab on the Edit Lot dialog box. 
5. Click Apply to save the changes, or click OK to save the record and 

close the dialog box. 
 

1. From the Edit Lot dialog box, select the Storage tab. 
2. Select the record row to delete, and then click the Delete Distribution 

button. 
3. Click Apply to save the changes, or click OK to save the record and 

close the dialog box. 
 

A container is some type of storage that holds materials. Some containers, 
such as a bin or tank, hold one material, while others, such as a pallet, can 
hold multiple materials. Containers can be a source for materials (adding 
materials from the container) or the destination for materials (such as the 
distribution of a finished product). 

From the Containers tab you can add or remove source containers, by location 
or individually, to the material’s Configured Containers list. When you 
distribute the material you select a container from the list. Only the containers 
configured to hold the lots of this material are used in the execution of a 
recipe. 

Deleting a sublot 

Configuring containers 
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If the containers are not configured, the Source Containers list only displays 
the virtual container. There are two methods you can use to configure 
containers: 

• Create the containers first, create the materials second, and then 
assign containers to materials. 

• Create materials first and assign them to the virtual container. As you 
create the containers, reassign the materials. (See Configuring storage 
containers on page 55 for more information.) 

 

1. From the Edit Material dialog box, select the Containers tab. 

 
2. There are three methods you can use to move containers from the 

Source Containers list to the Configured Containers list. 

• To add a storage location of containers, select a location from the 
Source Containers list, and then click the Add Location button. All 
the containers assigned to that location are added to the Configured 
Containers list. 

• To add an individual container, expand the location group to display 
the containers assigned to that location. Select an individual 
container, and then click the Add button. 

• To add all the source containers to the configured containers, click 
the Add All button. 

3. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

Removing a container merely unassigns the material from that container. The 
container definition still exists in the material database. 

1. There are three methods you can use to move containers from the 
Source Containers list to the Configured Containers list. 

• To remove a single container, select the container in the Configured 
Containers list, and then click the Remove button. 

• To remove more than one container, select the container in the 
Configured Containers list, hold down either the shift key or the ctrl 

Assigning containers to 
materials 

Removing a container 
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key, select other containers to remove, and then click the Remove 
button. 

• To remove all the containers in the Configured Containers list, click 
the Remove All button. 

2. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

The priorities of a material are used to select a container of material that you 
want to use first; for example, a container that has the oldest material needs 
to be used before newer materials. In the Priorities column, the default 
priority value is 100. The allowed values are 1 to 100, with 1 being the lowest 
value, which is selected first. You can assign as many priorities per container 
as needed. If the container with the value of 1 runs out of material, the next 
priority for that container is used. 

The Priorities tab displays area model data, which is loaded into the material 
database by a FactoryTalk Batch Server during start up. If no information is 
visible, then the database does not contain the area model data. 

1. From the Edit Material dialog box, select the Priorities tab. Existing 
containers assigned to the material display in ascending order by 
container name. You can sort the list by clicking the column header to 
display an up arrow (ascending) or down arrow (descending). 

 
2. In the Priority box, type a value from 1 to 100. 
3. Click Apply to save the changes, or click OK to save the changes and 

close the dialog box. 

The Inventory tab displays a view of the material lot distribution. Each row 
represents a sublot. A sublot is an amount of material in the selected lot that is 
distributed to a container. The container, lot, and label are used by the 
FactoryTalk Batch Server when searching for a material to bind to a recipe. 
When the recipe is complete, the FactoryTalk Batch Server updates the 
amount to reflect the amount of material either consumed from the container 
(Addition) or added to the container (Distribution). You configure the 
container type in the FactoryTalk Batch Equipment Editor. (See the 
FactoryTalk Batch Equipment Editor User Manual for more information). 

When you edit, distribute, or delete a distribution in a material’s inventory, 
the results also affect the container’s inventory. 

Configuring material 
priorities 

Configure material inventory 

Changing a sublot quantity 
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1. From the Edit Material dialog box, select the Inventory tab. Existing 
sublots display in ascending order by label name. Each record row 
represents a sublot. You can sort the list by clicking the column header 
to display an up arrow (ascending) or down arrow (descending). 

 
2. Select the record row, and then click the Edit Distribution button. The 

View Lot Distribution dialog box opens. 

 
3. In the Quantity box, type a new amount. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

4. Click OK to return to the Inventory tab on the Edit Lot dialog box. 
5. Click Apply to save the changes, or click OK to save the record and 

close the dialog box. 

1. From the Edit Material dialog box, select the Inventory tab. 
2. Select the row to delete, and then click the Delete Distribution button. 
3. Click Apply to save the changes, or click OK to save the changes and 

close the dialog box. 

Deleting a sublot 
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Managing lot distribution from the Inventory tab gives you an opportunity to 
adjust the inventory levels in containers. 

1. From the Edit Material dialog box, select the Inventory tab. 
2. Select the record row, and then click the Distribute button. The 

Distribute Lot dialog box opens. 

 
3. In the Label box, type a unique name for the sublot. 
4. In the Quantity box, type the amount to distribute. 
5. From the Storage Container list, select a container to store the 

distributed amount. 
6. Click OK to return to the Inventory tab on the Edit Lot dialog box. 
7. Click Apply to save the changes or click OK to save the changes and 

close the dialog box. 

1. In either the Hierarchy pane or Detail pane, right-click the material to 
delete, and then click the Delete button. 

2. If the Confirm deletion user preference is enabled, you are asked to 
verify the deletion. To delete the material, click Yes; to cancel the 
deletion, click No. 

If the Confirm deletion user preference is disabled, the selection is 
deleted without a confirmation message. (See Configuring the 
Material Editor on page 15 for more information.) 

 

Managing inventory 
distribution 

Deleting materials 
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Chapter 7 

Configuring storage containers and locations 

Independent containers are the actual elements that contain the lot(s) of 
material(s) that are used by FactoryTalk Batch in the execution of a recipe. A 
material storage container can be anything that either contains or acts as a 
location for lots of material (tank farm, vessel, or pallet). The containers can 
either be grouped within material storage locations for convenience or can 
remain as independent containers. 

Each material storage location is an independent entity that represents the 
location of the containers where lots of materials are stored. Locations can 
contain a grouping of containers related to that location. Examples of 
locations are warehouses and plants. What is important about material 
storage locations is the knowledge of what lot(s) of material(s) reside in or on 
that particular location. If you make changes to the configuration in the plant, 
you have to open the area model, make the changes, save it and restart the 
server. By using storage locations, you can feed material from a location 
instead of an independent container. By moving the container from location 
to location in the material database, you will not need to modify the 
equipment database. 

You can add storage containers individually or to the Independent 
Containers group. When adding a container, a general description of the 
container must be created before you can define the properties of the 
container. There are three types of containers: Composite, Plug Flow, and 
Pallet. 

• A composite container holds more than one lot, but the lots are mixed.
You cannot distinguish between lots, therefore the lot IDs do not
matter, and you will not keep inventory on the lot. For example, a tank
can be filled with one lot of milk. When another lot of milk is added,
the two lots become mixed, and are, therefore, indistinguishable from
one another. 

• A plug flow container holds one type of material, but is comprised of
two or more different lots. The first lot that went in is the first to come
out. For example, you can add a lot of grain to a silo containing another
lot of grain and the two lots remain separate (for the most part). Each
lot can be inventoried. 

• A pallet can have multiple materials, which usually are bags of a
specific quantity of material. For example, a pallet could be stacked
with 100 pound bags of flour, sugar, and cocoa. 

Configuring storage 
containers 
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Composite 

 
Plug Flow 

 
Pallet 

Description Contains like material Contains multiple sublots layered in 
vessel 

Contains multiple materials 

# of materials container 
may hold 

1 1 n 

# sublots container may 
hold 

1 n n 

Access to sublots Sequential Sequential Random 
Sublots trackable? No; anything added is 

combined with original 
sublot 

Yes; assumption is that active sublot 
is at bottom of vessel 

Yes; any sublot is always accessible 

 

1. Right-click Independent Containers, and then select New Material 
Storage Container. The Create Material Storage Container dialog box 
opens to the General tab. 

 
The following is a list of the items on the General tab of the Create 
Material Storage Container dialog box: 
Item Description 

Name Unique name assigned to the container. 

Description Detailed description of the container (optional). 
Capacity Amount of material a storage container can hold. 

Creating a storage container 
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Item Description 

Heel Quantity of material remaining in a container when emptied. For a container to be 
considered a binding candidate for material additions, the total inventory of the container 
must be greater than the heel value. The heel is not applicable to material distributions. 
(See Using container heel properties on page 69 for more information.) 

Engineering Unit Unit of measure for the material (optional). 

Storage Location Location where the container is added. 
State State of the container indicating the availability of a material. 
Controller ID If left at 0 (zero), defaults to the next numeric value in sequence. You can assign a unique 

number for PCD phase programming. 

Container Type Type of container: Composite, Plug Flow, or Pallet. 

 

 
Tip: If you want to use a container for phase binding, its State must be set to Ready to Use, 
otherwise the FactoryTalk Batch Server will not view the container as eligible for binding. 

2. Type the information in the appropriate boxes to define the container. 
3. Click Apply. The Edit Material Storage Container dialog box opens to 

the General tab. Once you created the general container record, you 
can configure the container properties, priority data, materials, and 
contents. 

IMPORTANT When you add a new container or modify an existing container in the Material Editor, 
the area model is not automatically updated. To update the area model open the 
Equipment Editor. 

 

The Properties tab contains a list of custom attributes that can be associated 
with the container. This data is optional information and is not required. 
Custom attributes always have indexes starting at 1000. Since a container 
class can also be represented as a collection of containers, the Properties tab 
allows you to add numerous records to make a collection. 

For containers that might have the same custom properties, you can duplicate 
properties with the same Controller ID to multiple containers. For example, if 
two containers have a pH_Factor property, you can assign the property to 
both containers using the same Controller ID. 

1. From the Edit Material Storage Container dialog box, select the 
Properties tab. 

Configuring container 
properties 
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2. Click the New Property button to insert a new property record row. 

 
The following is a list of the items on the Properties tab: 
Item Description 

Property Name Unique name assigned to the property (required). 

Type Represents the data type for the provided value (required). There are three data types 
supported: Real, Integer, and String. 

 
Tip: Unsigned data types introduced in Logix5000 version 32.00 are not 
supported by FactoryTalk Batch. Configuring a FactoryTalk Batch tag to 
reference a controller tag of any unsigned data type (USINT, UINT, UDINT, 
ULINT) will result in bad communication. If you attempt to run batches 
referencing any tags that include one of these data types a communication 
failure occurs at the point when the tag is used.  
Use FactoryTalk Batch Tag Verify to produce a report that identifies any issues 
with the tag(s). 

 

Value The value of the container property. 

Eng. Units The unit of measure being used for the material. 
Controller ID ID numbers begin at 1000 and increment by 10 for each attribute added. You can change 

the controller ID to a unique number for use in PCD phase programming. 

Description Detailed description of the container property. 

3. Type the information in the appropriate boxes to define the container 
properties. 

4. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 
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1. From the Edit Material Storage Container dialog box, select a record 
number to edit and click the Edit Property button. 

 
2. Modify the container property as needed, and then click OK. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

3. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

 

1. From the Edit Material Storage Container dialog box, select a record 
row to delete, and then click the Delete Property button. 

2. Click Apply to save the changes to the properties, or click OK to save 
the changes and close the dialog box. 

 

From the Materials tab you can add or remove source materials, by group or 
individually, to the container. 

1. From the Edit Material Storage Container dialog box, select the 
Materials tab. 

 
2. There are three methods you can use to move materials from the 

Source Materials list to the Configured Materials list. 

Editing container properties 

Deleting container 
properties 

Configuring container 
materials 
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• To add a group of materials, select a group from the Source 
Materials list, and then click the Add Class button. All the materials 
assigned to that class are added to the Configured Materials list. 

• To add a single material, expand a material group to display the 
materials. Select a material, and then click the Add button. 

• To add all the source materials to the configured materials, click the 
Add All button. 

3. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

Removing a material merely unassigns the material from that container. The 
material definition still exists in the material database. 

1. There are three methods you can use to move materials from the 
Configured Materials list to the Source Materials list. 

• To remove a single material, select the material in the Configured 
Containers list, and then click the Remove button. 

• To remove more than one material, select a material in the 
Configured Materials list, hold down either the shift key or the ctrl 
key, select other materials to remove, and then click the Remove 
button. 

• To remove all the materials in the Configured Materials list, click 
the Remove All button. 

2. Click Apply to save the changes, or click OK to save the record and 
close the dialog box. 

The priorities of a container are used to select materials that you want to use 
first. For example, the oldest material needs to be used before newer 
materials are used in a recipe, so you can set priority values for each 
container. The default priority value is 100. The allowed values are 1 to 100, 
with 1 being the lowest value, which is selected first. You can assign as many 
priorities per material as needed. If the container with a value of 1 runs out of 
material, the next priority container for that material is used. 

The Priorities tab displays area model data loaded into the material database 
by a FactoryTalk Batch Server during start up. If no information is visible, 
then the database does not contain the area model data. 

Removing a material 

Configuring container 
priorities 
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1. From the Edit Material Storage Container dialog box, select the 
Priorities tab. 

 
The following is a list of items in the Priorities tab: 
Item Description 

Material Unique name of the material stored in the container (view-only). 

Priority The priority ranking of the container (required). 
Area The area model name loaded by the FactoryTalk Batch Server (view-only). 
Cell The cell class instance configured in the area model, that has the container assigned to it 

(view-only). 

Unit The unit class instance configured in the area model that has the container assigned to it 
(view-only). 

Usage The type of usage configured in the area model, which determines if the container is an 
addition of material, distribution, or both (view-only). 

2. In the Priority column, select a record row to edit, and then type a 
value from 1 to 100. 

3. Click Apply to save the changes, or click OK to save the changes and 
close the dialog box. 

The Inventory tab displays a view of the distribution of the lots of material in 
the selected container. Each row represents a sublot. A sublot is an amount of 
material in the selected lot that has been distributed to a container. The 
material, lot, and label are used by the FactoryTalk Batch Server when 
searching for a material to bind to a recipe. 

When you edit, distribute, or delete a distribution in a container’s inventory, 
the results also affect the material’s inventory. 

Configuring container 
inventory 

Changing inventory quantity 
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1. From the Edit Material Storage Container dialog box, select the 
Inventory tab. The list of sublots for the storage container displays. 

 
2. Select the record row to edit, and then click the Edit Distribution 

button. The View Lot Distribution dialog box opens. 

 
3. In the Quantity box, type a new amount, and then click OK. 

IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 
value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

 

From the Edit Material Storage Container dialog box, select the record row to 
delete, and then click the Delete Distribution button. 

When you distribute a sublot of material, the distributed sublot appears with 
the Label, Container, and Amount distributed in the inventory of the selected 
storage container and also in the materials inventory. 

Deleting a distribution 

Distributing a lot 
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1. From the Edit Material Storage Container dialog box, select the record 
row to distribute, and then click the Distribute button. The Distribute 
Lot dialog box opens. 

 
2. In the Label box, type a unique label name for the sublot. 
3. In the Quantity box, type the amount to distribute. 
4. From the Storage Container list, select a container to use for storing 

the distributed amount. 
5. Click OK to return to the Inventory tab. If you distributed the lot into 

the container in which you are working, the new sublot displays, with 
the Label, Container, and Amount distributed in the inventory. 

 
When a sublot of a lot of material is used up, the sublot is deleted from the 
database. You can create a new quantity of that same sublot, using the Create 
Distribution button. 

Adding a new quantity of 
material to a deleted sublot 
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1. From the Edit Material Storage Container dialog box, click the Create 
Distribution button. The Create Lot Distribution dialog box opens. 

 
2. In the Label box, type a unique label name for the sublot. 
3. In the Quantity box, type the amount being distributed. 
4. In the Material Lots list, select a lot of material to distribute. 
5. Click OK to save the changes and close the dialog box. 

1. In either the Hierarchy or Detail pane, right-click a container, and then 
select Properties. The Edit Material Storage Container dialog box 
opens to the General tab. The container name displays in the title bar. 

2. Make the necessary changes to the storage container. 
IMPORTANT If you are changing a value that contains a decimal, use the Delete key to delete the 

value before typing a new value that contains a decimal. If you type over the old 
value containing the decimal, the new decimal is not recognized by the application. 

3. Click OK to save the changes. 

1. In either the Hierarchy pane or Detail pane, right-click a container, 
and then select Delete. 

2. If Confirm deletion is enabled on the User Preferences dialog box, a 
confirmation message displays. To delete the storage container, click 
Yes. 

If Confirm deletion is disabled on the User Preferences dialog box, the 
storage container is deleted without a confirmation message. (See 
Configuring the Material Editor on page 15 for more information on 
defining the user preferences.) 

Storage locations represent the locations of actual material storage 
containers. When adding new locations, you must add a record of the location 
before you can configure it. 

Editing storage containers 

Deleting storage containers 

Creating storage locations 
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1. In the Hierarchy pane, right-click Locations, and then select New 
Material Storage Location. The Create Material Storage Location 
dialog box opens. 

 
2. In the Name box, type a unique name for the material. 
3. In the Description box, type a detailed description of the material. 
4. In the Controller ID box, type a unique number if desired. If left at 0 

(zero), the Controller ID defaults to the next numeric value in 
sequence. 

5. Click OK to save the new location and close the dialog box. 
6. In either the Hierarchy or Detail pane, right-click the storage location, 

and then select New Material Storage Container. 
7. Configure the material storage containers for this storage location. 

(See Configuring storage containers on page 55 for more information.) 
  



Chapter 7  Configuring storage containers and locations 
 

66 Publication# BWMTR-UM001B-EN-D - May 2022  
 

1. In either the Hierarchy or Detail pane, right-click a storage location, 
and then select Properties. The Edit Material Storage Location dialog 
box opens to the General tab. 

 
2. Make any necessary changes to the general information, and then click 

Apply. 
3. Select the Materials tab. The materials assigned to this storage 

location display. 

 
To make any changes to the list of configured materials, you need to 
edit the storage container located in the storage location. (See Editing 
storage containers on page 64 for more information.) 

Editing storage locations 
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4. To view material properties, double-click a material. The View 
Material dialog box opens. 

 
You only can view the material’s property values. To edit the values, use 
the Edit Material dialog box. (See Creating a material record on page 
41 for more information.) 

5. Click Close to close the dialog box. 
 

1. To delete a location, right-click on a location and select Delete. 
2. If Confirm deletion is enabled on the User Preferences dialog box, a 

confirmation message about the selected location opens. To delete the 
location, click Yes. 

If Confirm deletion is disabled on the User Preferences dialog box, the 
storage location is deleted without a confirmation message. (See 
Configuring the Material Editor on page 15 for more information on 
defining the user preferences.) 

 
Tip: You cannot delete a material storage location that has material storage containers assigned to 
it. You must either reassign or delete the containers, and then you can delete the storage location. 

 
 

Deleting storage locations 
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Chapter 8 

Using container heel properties 

The container heel is the specified quantity of inventory within a container that 
cannot be removed as part of a material addition. For material addition 
binding, the container is effectively empty when inventory drops below this 
level. 

Material distributions do not have a use for the heel property. When the total 
amount of inventory in the container is less than the heel property, the 
container is not empty. The selection of the container for a material 
distribution must follow the binding rules for distribution binding by 
container type. 

For a container to be considered a binding candidate for a material addition 
step, the total of all inventory of the same material within a container must be 
greater than the container’s heel property. 

When the quantity of inventory within a container is less than the heel 
property, the container will not be considered available for binding. This 
prevents containers that are effectively empty from being reselected to add 
material to a batch. 

Composite Container Example: 
Composite containers have only one sublot. The total inventory is the quantity 
of that sublot. 

Plug-Flow Container Example: 
Plug-Flow containers may only contain one material, but may have many 
sublots. The sublots are assigned ascending ordinal values as they are put into 
the container. Sublots are assumed to be consumed in ordinal order, lowest to 
highest value, thus creating a first in/first out (FIFO) queue of inventory. 
Consumption may span multiple sublots. 

Composite Container

Material = Wort
Lot = ABC1234

Total inventory = 
600 gallons

Quantity = 600 gallons

Heel property = 50 
gallons

Binding Sublot:

Material = Wort
Lot = ABC1234
No Label Applied



Chapter 8  Using container heel properties 
 

70 Publication# BWMTR-UM001B-EN-D - May 2022  
 

Total inventory is the sum of all sublots within the Plug-Flow container. 

 

Pallet Container Example: 
Pallet containers may contain any number of materials, and may have many 
sublots. In the example below, there are six sublots of Salt and two sublots of 
Pepper. The sublots are assigned ascending ordinal values by material as they 
are put into the container. Sublots are assumed to be consumed in ordinal 
order, lowest to highest value, thus creating a first out, first in queue of 
inventory. Consumption may span multiple sublots. 

 

Total inventory is the sum of all sublots of the same material within the within 
the Pallet container. The example pallet has three total inventory values; Salt: 
600 pounds, Pepper: 200 pounds and Sugar: 80 pounds. The heel property, 99 
pounds, is applied to each of these materials. Considering only the Total 
Inventory/Heel Property rule, this pallet would be a binding candidate for 
material specifications for Salt and Pepper, but not Sugar. 

The container heel property of a container supports being downloaded to 
phase logic. The 7800, 17800, 8000 and 18000 series phase requests to 
download data from the Material Database are used to download the heel 
property of any container. 

The container heel property of a container supports being uploaded from 
phase logic. The 7800, 17800, 8000 and 18000 series phase requests to upload 

Plug-Flow Container

Total inventory = 
1040 gallons

Ordinal = 4
Qty = 490 gallons

Heel property = 50 
gallons

Binding Sublot:

Material = Malt
Lot = XYZ123
No Label Applied

Material = Malt
Lot = XYZ123

Material = Malt
Lot = UVW456

Material = Malt
Lot = XYZ123

Ordinal = 3
Qty = 210 gallons

Ordinal = 2
Qty = 340 gallons

Total Pallet Inventory:     Salt = 600 pounds     Pepper = 200 pounds     Sugar = 80 pounds

Binding Sublot: All

Material = Salt; Lot = Lot_1
Label = Monday; Ordinal = 1

Qty = 100 pounds

Material = Salt; Lot = Lot_2
Label = Tuesday; Ordinal = 2

Qty = 100 pounds

Material = Salt; Lot = Lot_3
Label = Thursday; Ordinal = 3

Qty = 100 pounds

Material = Salt; Lot = Lot_1
Label = Friday; Ordinal = 4

Qty = 100 pounds

Material = Sugar; Lot = Lot_1
Label = none; Ordinal = 1

Qty = 80 pounds

Material = Pepper; Lot = Lot_2
Label = Monday; Ordinal = 3

Qty = 100 pounds

Material = Salt; Lot = Lot_3
Label = Sunday; Ordinal = 6

Qty = 100 pounds

Material = Salt; Lot = Lot_2
Label = Saturday; Ordinal = 5

Qty = 100 pounds

Heel Property = 99 pounds

Accessing the heel property 
from phase logic 
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data from the Material Database are used to upload a value to the heel 
property of any container. 

The 7800, 17800, 83NN, 183NN, 87NN and 187NN phase requests require an 
integer to identify the property to be referenced. For containers, the Heel 
Property will have an index of 10. 

The Container object has been updated to include a property called heel. 

Assigning a new heel property, like all material objects, requires replacing the 
whole container: 

InsertContainer(objContainer as Container) 

or updating an existing container by updating the whole object: 

UpdateContainer(objContainer as Container) 

 

Material object model 
support for heel property 
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Rockwell Automation support 
Use these resources to access support information. 
Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification updates. rok.auto/support 

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase 
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport 

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature 
Product Compatibility and Download Center 
(PCDC) 

Get help determining how products interact, check features and capabilities, and find 
associated firmware. 

rok.auto/pcdc 

Documentation feedback 
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the form at 
rok.auto/docfeedback. 

Waste Electrical and Electronic Equipment (WEEE) 

At the end of life, this equipment should be collected separately from any unsorted municipal waste. 

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec. 
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